GSAK 101!

Dies ist eine schrittweise Einweisung in GSAK. Jeder unterstrichene Textteil

ist ein Link zu einer Website — klicke auf den Text, um direkt dorthin zu

gelangen. Diese Einfuhrung ist sehr ausfuhrlich (Schritt fur Schritt) und

deshalb ziemlich lang. Keine Sorge! Wenn Du ihn durchgearbeitet hast kannst
Du GSAK sofort aleine benutzen.

Bitte beachte: dieses Handbuch ist eine Einfiihrung in GSAK. Es sollte von Anfang bis
Ende durchgelesen werden (wenngleich nicht unbedingt auf eéinmal), und jedes Kapitel
baut auf das vorherige auf. Wenn Du Kapitel liest, ohne die vorherigen gelesen zu
haben, werden Dir Grundlagen fehlen und Du wirst das Programm nicht verstehen.

Englische Bezeichnungen der Bedienelemente von GSAK werden unmittelbar danach in
[eckigen Klammern] erl&utert.

Viele Merkmale von GSAK werden hier nicht behandelt — weitere Informationen erha tst
Du durch die GSAK-Hilfe (klicke im Hauptmenue “Help” und dann “ Contents” an oder
driicke die F1-Taste).

GEOCACHING.COM PREMIUM MEMBERSHIP

Um GSAK vollstandig ausntitzen zu konnen, musst Du GPX (und nicht L OC)-Dateien
von Geocaching.com herunterladen. GPX-Dateien beinhalten fast alle Informationen der
Cache-Seite und ermdglichen Dir, ale diese Informationen in GSAK zu laden. LOC-
Dateien enthalten nur den Cache-Namen und die dazugehdrigen Koordinaten. Obwonhl
GSAK auch mit LOC-Dateien arbeitet, erhaltst Du mit diesen keine detaillierten Cache-
Beschreibungen, mit denen Du die vielféltigen Vorteile von GSAK nutzen kannst.

Geocaching.com setzt eine “Premium Membership” voraus, um . @&
GPX-Dateien laden zu kdnnen. Die Kosten fir eine Premium-
M embership betragen monatlich $3.- oder jéhrlich $ 30,-.

Klicke auf http://www.geocaching.com/subscribe/ und gehe
anschlief?end auf “How Much is Membership”. Hier kannst Du
Dich as Premium Member anmelden, die Mitgliedsdauer und
die Zahlungsmethode (Kreditkarte oder PayPal) wahlen. Mit

der Bezahlung bist Du Premium Mitglied und Du kannst GPX-  ceac ACHING.COM
Dateien und Pocket Queries herunterladen.

DowNLOAD VON GSAK

Rufe http://gsak.net/ auf und lade die neueste Verson von GSAK auf Deinen Rechner
und sichere die Datel anschlief3end in ein separates Verzeichnis.


http://www.geocaching.com/subscribe/
http://gsak.net/

Zum Testen ist GSAK kostenlos und man kann esfir $ 20,- erwerben. Die Shareware-
Version beinhaltet die komplette GSAK-Version und ist voll funktionsfahig. Wenn man
GSAK 21 Tage lang ohne Registrierung benutzt hat, erhdtst Du nach dem Start des
Programms einen ,, Hinweis* und dieser wird mit jeder weiteren Nutzung langer auf dem
Bildschirm erscheinen. Wenn Dir das Programm zusagt, bitten wir um Registrierung
unter http://gsak.net/Register.php. Nach Eingabe des Reg-K eys (Serien-Nummer), wird
der Hinwels auf dem Bildschirm nicht mehr erscheinen.

INSTALLATION VON GSAK

Klicke auf die Start-Taste und dann auf “ Ausfuhren” und suche im Verzeichnis, in dem
Du die heruntergeladenen Datei gespeichert hast nach “GSAKxxxx.exe", (xxxx ist die
Versionsnummer). Nach einem Klick auf die Datei einfach ,, Open” und dann ,, OK*
anklicken.

Nun behinnt die Installation von GSAK. Beim Erscheinen der Meldung “Open File
Security Warning Appears’ einfach ,,Run” anklicken.

Es wird vorausgesetzt, dass Du einwilligst GSAK in das ausgewahlte Verzeichnis zu

installieren. Nach dem Anklicken auf ,, Next*, , Accept”, ,Next“ und ,, Install* wird
GSAK auf dem Computer installiert.

DER ERSTE START VON GSAK

ﬂ'l' Du startest GSAK mit eitnem Doppelklick auf das Icon (eine rote Flagge mit
einem weil¥en Kreuz) auf dem Desktop.

Du wirst gefragt, ob Du GPX- und LOC-Dateien mit GSAK “Associate” [=verkntpfen]
willst. Dies bedeutet, dass jegliches Anklicken einer solchen Datei GSAK 6ffnet. Wenn
Du weitere Geocaching-Software auf Deinem Computer hast und trotzdem immer GSAK
nach einem Doppelklick auf GPX- und LOC-Dateien verwenden méchtest, musst Du
»Force Association Each Time GSAK starts” [=Verbindung mit GSAK bel jedem Start
bevorzugen] markieren. Dies verhindert, dass andere Software diese Verkntpfungen mit
benutzt.

Wenn Du méchtest, dass GSAK beim Doppelklick auf GPX- oder L OC-Files gedffnet
wird, musst Du “Associate’ [=verknipfen] anklicken. Wenn Du mdchtest, dass andere
Programme getffnet werden, musst Du ,,Cancel” [=abbrechen] anklicken. Wichtig: Du
kannst diese Einstellungen in GSAK jederzeit andern, indem Duim “Tools”
[=Werkzeuge]-M enue Veranderungen wie oben ausgefihrt unter “GPX File
Association...” durchfihrst.

Als nachstes wird GSAK on Du die Beispiel-Daten auf Deine Datenbank hochladen
mochtest. Wenn Du sofort reale Daten hochladen méchtest, klicke auf ,,no* [=nein],


http://gsak.net/Register.php

wenn Du Dich zuerst mit den Beispieldaten beschéftigen willst, klicke bitte auf ,, yes"
[=ial.

Nun 6ffnet das “ Getting Started” [=ins Laufen bringen]-Menue. Arbeite Dich durch
dieses Hilfe-Themadurch und klicke auf die Links um mit den Grundlagen des
Programms und seinen Hilfsordnern vertraut zu werden. Befurchte nicht, dass Du sofort
alles auswendig lernen musst — Du wirst Schritt fur Schritt durch die Grundlagen des
Programms gefiihrt.
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DIE VERWENDUNG VON GSAK

L aden von Cache-Daten: Als erstes musst Du einige Cache-
Daten in das GSAK-Programm laden. Du kannst individuelle
Cache-Daten laden, oder kannst —wenn Du ein Premium
Member bist — Pocket Queries bei geocaching.com erstellen,
womit Du Informationen von bis zu 500 Caches per Email
zugestellt bekommst (dies wird weiter unten erklart).

Von jetzt an wird vorausgesetzt, dass Du Premium Member bei Geocaching.com bist, da
Du so optimale Informationen fir die Verwendung von Cache-Daten unter GSAK
erhaltst.

Erstelle unter Windows einen Ordner in “My Documents” um hier Deine
herunztergeladenen Dateien speichern zu kénnen. Nenne diesen Ordner z. B.
,Geocaches”.

L aden von individuellen Cache-Daten: Um Daten fiir einen individuellen Cache
herunterladen zu kdnnen, musst Du bei Geocaching.com eingeloggt sein. Gehe auf die
Cache-Seite und klicke links oben (unter der Koordinaten- und Entfernungsangabe) bei
“Click Icon to Download” auf “ GPS eXchange File (*.gpx)”. Im Fenster
»Dateidownload” auf ,, Speichern“ klicken um die Datei in dem zuvor erstellten Ordner
(siehe oben) z. B. ,,Geocaches* abzulegen.

Click icon to download:
5 LOC waypoint File ¢ loc) 5 GPS exchanoe File (*.gpx)
Bead about wavpoint downloads




L aden von Cache-Daten in das GSAK -Programm: Klicke in GSAK-Menue auf
“File’ [=Datei] und dann auf ,,Load GPX/LOC* [=Lade GPX/LOC-Dateien] (ab hier
werden Menue-Befehle folgendermassen z. B. dargestellt: , File>Load GPX/LOC). Das
Fenster, welches sich nun 6ffnet fordert Dich auf die Art festzulegen, wie Du eigene
Caches behandeln mochtest. Dies ist ein wichtiger Schritt, damit GSAK Dich erkennt und
somit Deine eigenen und gefundenen Caches erkennen kann. Schreibe Deinen
Geocaching-Namen in das vorgesehene Feld (doppelt um sicher zu stellen, dass kein
Schreibfehler enthalten ist) und klicke auf ,, OK*. Diese Eingabe muss nicht wiederholt
werden, da die eingegebenen Daten gespeichert werden.

Nun 6ffnet der ,Load...."-Diaog. Klicke auf das kleine Icon auf der rechten Seite und
wéhle Deinen “ Geocache” -Ordner. Klicke auf die Datei, die Du gerade heruntergel aden
hast, klicke auf ,, Open” [=06ffnen] und dann auf , OK“. GSAK |&adt die Cache-
Informationen in seine Datenbank und die sich 6ffnende , Load Summary* [=Ubersicht
Uber heruntergeladene Dateien] zeigt Informationen Uber die eben geladene Datei. Klicke
auf ,OK*“.

Du wirst sehen,m dass der Cache nun in einer Reihe in der oberen Halfte von GSAK
erscheint. Dieswird ds,, Grid View" [=Rasteransicht] bezeichnet und jede Reihe enthalt
Informationen Uber einen Cache.

Oberhalb der Rasteransicht erlautert eine Statuszeile: Subset [=ausgewahlt]: None
[Keines]; 1 Shown (all waypoints) [=einer angezeigt (alle Wegpunkte)]; Center Point:
Greenwich Meridian [=Mittelpunkt: Nullmeridian]; Counts [=Z&hlung] (gefolgt von 4
verschieden farbigen Feldern).

Klicke auf die untere Ecke der Statusleiste und halte die M austaste gedrtickt um sie nach
oben ziehen zu kénnen. Wenn dies nicht mdglich ist, einfach die ,, F2*-Taste driicken
(was die Bildschirmansicht aufteilt), um so die Statuszeile aufwarts bis in die Mitte des
Bildschirms zu ziehen.

Nun siehst Du die Cache-Information im unteren Bereich des Bildschirmfensters. Dies
wird als,, Split Screen View” [=geteilte Bildschirmansicht] bezeichnet.

Das vorgegebene Format ist “Voller Bildschirm”. Dies zeigt ale Cache-Informationen,
diein der GPX-Datei enthalten sind, so dass man nicht mehr zu Geocaching.com
wechseln muss. In der Mitte der Statusleiste, relativ weit oben, findest Du ein Icon ,, Split
Screen Format® [=Bildschirmformat aufteilen]. Betrachte die unterschiedlichen
Moglichkeiten (Achtung: fir diesen Schritt muss eine Internet-Verbindung hergestel It
sein!). Stelle das Bildschirmformat anschlief3end wieder auf ,, Full Display” [=ganzer
Bildschirm] ein.

gl

Er stelle Deine Home-K oor dinaten: Eine der Starken von GSAK
ist die Mdglichkeit, Caches in Bezug auf die Entfernung zu einer



vorgegebenen Ortlichkeit darzustellen. Wenn Du nicht auf dem Nullmeridian in England
wohnst (was sehr wenige tun!), musst Du Deine ,,home location* [=Wohnort] anlegen,
die angibt, bei welchen Koordinaten Du wohnst.

Als erstes muf3t Du Deine Helmat-K oordinaten ermitteln. Wenn sie Dir nicht bekannt
sind, ermittle diese mit Deinem GPS und kopiere die Koordinaten folgendermal3en ins
GSAK:

Gehe zu Tools>Options und klicke auf das “Locations’- Aymbol. Klicke unterhalb
“#Somewhere else....” im Textfeld und schreibe Home, eéin Kommaund dann Deine
Heimatkoordinaten, wieder getrennt durch ein Komma. Beachte, dass die Koordinaten in
einer der Formen wie in den Beispielen gezeigt, eingegeben werden. Vergewissere Dich,
dass Du ein Komma zwischen Home, der Breiten- und der L angenkoordinate gesetzt
hast. Vergewissere Dich ebenfalls, dass die Breitengrad- vor L angengrad-K oordinate
gesetzt wurde. Vergewissere Dich ferner, dass die Koordinaten exakt stimmen,
einschliellich N oder S (ndrdlich oder siidlich des Aquators) bzw. E oder West (6stlich
oder westlich vom Nullmeridian).

Klicke auf “OK” um zur GSAK Rasteransicht zurtickzukehren. Wahle das ,, L ocation* -
Menue der Symbolleiste den Menuepunkt ,,Home". In der Spalte ,, Kms* wird nun die
Entfernung des Caches zu Deinen Home-K oordinaten dargestelIt. Wenn Du eine
Darstellung in Meilen bevorzugst, wechsle zu Tools>Options, dann zum Registerkarte
»Genera” und klicke hier rechts oben ,,Miles* unter ,, Distance Calculation®
[=Entfernungsmessung] an. Klicke anschlief3end auf ,, OK*. Nun werden die
Entfernungen entsprechend in Meilen dargestel It.

V erarbeitung von Pocket Queries: Um den
groftmaglichen Vorteil von GSAK nutzen zu kénnen,
mochtest Du moglichst viele Cachesin die Datenbank laden
(beispielsweise alle Caches um Deinen Wohnort). Dies
macht man bevorzugt mit ,, Pocket Queries‘ von
geocaching.com. Detaillierte Informationen erhat man hierzu
Uber: http://www.markwell.us/pg.htm

Oder, wenn Du es auf gut Glick versuchen willst:
http://www.geocaching.com/pocket/ und klicke hier auf “Create a New
Query” (die Vorausstezung ist auch hier, dass Du als Premium Member
angemeldet bist).

Egal wie Du es machst, wenn Du ein Pocket Query an geocaching.com gesendet hast,
wird Dir normalerweise innerhalb weniger Minuten eine Datei zugemailt. Schau nach
Deinen Emails!

Ubertragen eines Pocket Queries nach GSAK: Der Weg ist fast identisch mit der
Ubertragung von von Einzelnen GPX-Dateien.


http://www.markwell.us/pq.htm
http://www.geocaching.com/pocket/

Sichere die Datel zuerst in Deinem “Geocaches’-Ordner (siehe oben).
Gehe als nachstes zu File>Load in GSAK und wechsle in den Geocache Ordner.

Klicke auf die gespeicherte Pocket Query Datei (beachte: GSAK kann komprimierte
Dateien selbststandig entpacken — dies muss vorher nicht gemacht werden). Klicke auf
,Open“. Dann auf ,OK". Die Caches des Pocket Queries (bis zu 500) werden nun in
GSAK geladen und eine Zusammenfassung erscheint in einem separaten Fenster. Mit
»OK* wird dieses Fenster geschlossen.

Ansicht der Cache-Informationen: Jede der Reihen beinhaltet die Daten von einem
Cache. Wenn Du auf einen Cache klickst werden dessen Detailsin einem
Bildschirmausschnitt angezeigt.

Wenn Du den Cache auf einer Landkarte darstellen mochtest musst Du online sein.
Klicke dann mit der rechten Maustaste auf die Cache-Reihe in der Rasteransicht und
bewege Deinen Cursor nach unten bis zur ,, Custom URL“ [=gewtnschte URL] und
wéhle eine entsprechende Karte aus (teste “ Google Satellite View” am Ende der Liste).

Sortierung: Durch Klicken auf die Spitze einer jeden Spalte konnen die Informationen
sortiert werden. Wenn Du z.B. auf die,, Code*-Spdte klickst werden die Caches nach
dem Geocaching-Code sortiert. Das gleiche gilt fir die Kms und alle anderen Spalten.
Ein nochmaliger Klick kehrt die Sortierung um.

Cachesauswahlen: Um einen Cache in GSAK auszuwahlen, musst Du in der Spalte

unter dem [ | Icon auf die Reihe des Caches klicken. Dieswird durch ein Hakchen, der
»user Flag* angezeigt. Diese Hakchen kdnnen fir einzelne Caches oder mehrere Caches
gesetzt werden. Fur mehrere Caches einfach mehrere Caches anklicken. Mehrere Caches
kann man auch aus dem ,,User Flag”-Menue oder mittels Kurzbefehl auswahlen (das
Anklicken des ,,User Flag“-Menues zeigt Dir die Mdglichkeiten.

Ein ntitzlicher Weg um eine grof3ere Anzahl von Caches zu selektieren ist User
Flags>Select for next nn records. Was bedeutet ,,nn records* ? Dies bedeutet die néchste
numerische (nn) Anzeige im GSAK Raster. Um dieses Merkmal nutzen zu kdnnen, musst
Du zunéchst einen Cache anklicken. Wahle danach ,,User Flags> User Flags>Select for
next nn records’. Schreibe nun z. B. “10” in das sich 6ffnende Feld und klicke auf “OK”.
Daraufhin werden 10 Caches unterhalb des selektierten Caches mit einem Hakchen
markiert sein.

Um die Selektion eines Caches zu |6schen, gentigt es, nochmals auf das Hackchen zu
klicken und die Markierung verschwindet. Um die Selektion mehrerer Caches riickgangig
zu machen wahlt man User ,, Flags>Clear all user flags* [=Hakchen>alle Hakchen
|6schen]. Dies macht die komplette Selektion riickgangig.

H erausfiltern: Das Herausfiltern ist eines der wichtigsten Bestandteile von GSAK.



Das Filtern erlaubt Dir, einen Anteil von Caches auszuwahlen und zu anderen
hinzuzuftigen. Du kannst 16schen, verschieben, exportieren oder eine Gruppe von Caches
an Dein GPS senden.

Wahle zur Demonstration durch Anklicken auf der “User Flag” -Spalte einige Caches aus.
Betatige nun die F8-Taste. Beachte, dass im Raster nun ausschliefdlich solche Caches
angezeigt werden, die Du mit einem Hakchen ausgewahlt hast. Wenn Du bereits andere
Caches ausgewahlt hast, kannst Du diese hinzuftigen. Gehe zu ,,User Flags>Clear al user
flags‘ oder driicke die F7-Taste um die Hakchen zu |6schen und wieder alle Caches
anzuzeigen.

Der GSAK-Filter kann wesentlich mehr. Um Deine Caches anderweitig zu filtern, musst
Du ,, Search>Filter* wahlen. Oder klicke auf die Filter-Taste der GSAK Symbolleiste, die
SO aussieht:

[&

Ein “Set Filter” [=Filter setzen] Fenster zeigt Dir die verschiedenen Mdglichkeiten auf.
M ehrere Registerkarten zeigen Dir die verschiedenen Mdglichkeiten, die Du zur
Selektion heranziehen kannst.

Ein einfacher Filter soll als Beispiel dienen. Du mdchtest z. B. alle Traditionalsin einem
Umkreis von 20 km um Deine Home-K oordinaten ermitteln. Klicke auf ,, Search>Filter”.
Auf der General-Registerkarte ist das 4. Kriterium von oben “Distance’ [=Entfernung].
Wahleim “Any Distance”’ [=jede Entfernung]-Fenster , Less than or Equal To*
[=weniger oder gleich]. Tippe 20 in das rechte Fenster flir die Entfernungsangabe.

Klicke nun auf die “Other” [=andere]-Registerkarte im “ Set Filter”-Fenster und klicke
“Clear All” [ale |6schen] unterhalb der Auflistung der Cache-Typen. Klicke danach im
Fenster links auf , Traditional”. Klicke nun auf ,,Go" unten links im Filter-Fenster. GSAK
wechselt nun zur Rasteransicht in der nun ausschlief3lich Traditionals angezeigt werden,
die sich innerhalb einer Entfernung von 20 km um Deine Heimkoordinaten befinden.

Du nach “ Search>Cancel Filter* wechseln oder dasrote X der Symbolleiste

m Um den Filter zu |6schen (und ale Deine gewahlten Caches anzuzeigen), musst
k anklicken.

Ubertragung von Waypoints auf Dein GPSr: GSAK kann einen einzelnen Wegpunkt
oder eine ,,Reihe” von Wegpunkten direkt zu Garmin- oder Magellan GPS-Empfangern
senden. Eine “Reihe* entspricht den angezeigten Caches in der Rasteransicht. So kdnnen
gefilterte Cachereihen direkt an dem GPS-Empfanger Ubertragen werden.

Wahle als erstes “GPS>Setup” . Wahle den Hersteller Deines GPS (Garmin oder
Magellan). Wenn Dein GPS ber einen USB-Anschlul3 (nicht einen USB-Serial-
Konverter), musst Du die ,, GPSr is USB*-Karte anwéhlen. Bei Verwendung eines
seriellen Anschlusses wird hier kein Haken gesetzt sondern der COM Anschluss
angegeben, an dem Dein GPS mit dem Computer verbunden ist. Bei Magellan muss
zusatzlich die Verbindungsgeschwindigkeit angegeben werden (da alle Garmin-Geréte



gleich sind, muss dies bei jenen nicht angegeben werden). Zum Schluss mussdie
maximale Anzahl der Wegpunkte — entsprechend dem Handbuch des Gerats — angegeben
werden, die verwaltet werden konnen. Bestétige anschlief3end mit ,OK*.

Nachdem Du mittels Filter die Cachesbzw. alle angezei gten Caches ausgewahlt hast,
musst Du versichert sein, dass die maximale Anzahl von Wegpunkten nicht Uberschritten
ist. Die Menge wird an der Statuszeile unten angezeigt.

Verbinde Deinen GPS-Empfénger mit dem Computer und schalte ihn an. Wechsle nun zu
»GPS>Send Waypoints* und klicke ,,Send* an. Die ausgewahlten Wegpunkte werden
nun Ubertragen.

Wenn Du weder ein Garmin- noch ein Magellan-Gerét hast? Oder wenn Du die
Wegpunkte an ein anderes Programm senden mochtest gibt Dir der néchste Punkt hierzu
eine Erlauterung.

Export: Wahle nach den obigen Angaben Caches aus.

Gehe zur Datel File>Export und wahle das Exportformat aus (zur Abstimmung fir
Deinen GPS-Empfanger oder die Software). Ein Dialogfenster erscheint fir das
ausgewahlte Exportformat. Wegen der Vielzahl der Exportformate kann hier nicht ndher
darauf eingegangen werden. Bitte beachte hierzu das “GSAK help file” fir
weitergehende Informationen (“Help>Contents* oder F1-T aste).

Wahle fur Hinweise zur Benutzung der Hilfe-Funktionen die entsprechende Rubril im
GSAK-Forum: http://www.gsak.net/board/index.php?showtopic=955& st=0& - entry5743

Geniese GSAK!

Weitergehende Informationen erhdltst Du bel GSAK 201 — Anpassung von GSAK, die
Du hier herunterladen kannst:
http://gsak.info/board/index.php?showtopic=2335& view=findpost& p=13777



http://www.gsak.net/board/index.php?showtopic=955&st=0&
http://gsak.info/board/index.php?showtopic=2335&view=findpost&p=13777

